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Navigation

Navigating Through Multimedia World History

There are many ways of navigating through Multimedia World History. You can view the different
areas available in Multimedia World History from the main screen, jump from one topic to
another from a hot spot, browse through topics that are related to one another, retrace your steps
backwards (topic by topic), or return to any previously viewed topic.



Navigation

Using Links

Topics are linked to one another by means of hot spots. A hot spot can be a word or phrase, or a
picture or part of a picture. Text hot spots are displayed in red. A picture hot spot may have a
border around it. You can identify a hot spot by noticing the mouse cursor: it changes to a pointing
hand when over a hot spot.

For example, point to the Navigation icon in the upper left-hand corner of this topic and you will
see the cursor change into a hand, as shown below:

If you click on this icon, it will jump to another topic, which in this case, is the Navigation menu.

In addition to jumping to other topics, hot spots can bring up popup windows. Popups are
displayed over the main window. To remove the popup, click anywhere outside of the popup, or
press the ESC key. Click on this hot spot to view a popup window.



Navigation

Jumping from Topic to Topic

The List button displays a popup window containing the topics available under the selected area.

To use the list feature to jump to another topic within the area you are located:
1 Choose the List button from the button bar at the top of the main window.

2 Highlight the topic you wish to view.
3 Double-click the selected topic to jump to it.

See Also
Using The Button Bar

Using The Topic Icons
Browsing through Multimedia Sequences



Navigation

Using The Topic Icons

The Topic Icons allow you to view the topics available under the selected work.
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Click an icon from this illustration to find out what action it performs.

See Also
Jumping From Topic to Topic
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Displays the previous topic in the browse sequence.
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Displays the next topic in the browse sequence.




Displays the multimedia options associated with the selected work. For more information see Using
Multimedia Icons
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Returns you to the text screen of the selected multimedia list.



Displays the previous work in the browse sequence.




Displays the next work in the browse sequence.
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Displays three to five quiz questions associated with the selected work.




Navigation

Returning to the Main Screen
The Home button, on the button bar, returns you to the main screen. This screen is like a control
panel, from which you can access the different features of Multimedia World History.

* Choose the Home button from any screen in Multimedia World History to jump to the main
screen.

See Also
Using the Main Screen Icons

Using The Button Bar



Navigation

Using the Main Screen Icons

The main screen icons allow you to jump to the various areas of Multimedia World Hlstory.

Click an icon from the following illustration to find out what action it performs.
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See Also

Returning to the Main Screen
GoTo Menu Commands



The Galleries icon jumps to the multimedia galleries screen. For more information see
Jumping to the Multimedia Galleries Screen, Using Multimedia Icons.




The Navigation by Subject icon jumps the the category screen which lets you
choose topics by category. For more information see Jumping to the Category Screen, Using
Multimedia Icons.




Timeline jumps to a scrolling timeline of historical events.



This Day in History jumps to the January Screen, the first screen of a catalog of historical events
by day of the year.



The Search icon displays the Search dialog box. For more information see Using Full-Text
Search.



The Exit icon exits Multimedia World History. For additional information see Eile Menu
Commands.



The About This Disc icon displays the Multimedia World History copyright and product information
including an order form for additional Bureau of Electronic Publishing, Inc. products.



Navigation

Jumping to the Multimedia Galleries Screen

The Galleries button jumps to the multimedia galleries screen.

To browse through the multimedia topics:
1 Choose the Gallery button from the button bar at the top of the screen.

2 Choose one of the multimedia icons to view a browse sequence of the available topics.

3 Choose a specific multimedia gallery from the pull-down Go To menu item.

See Also
Using Multimedia Icons

Browsing through Multimedia Sequences



Navigation

Jumping to the Category Screen

The navigation by subject icon on the main screen jumps to the category screen which
divides the titles on Multimedia World History into five categories: Books by Title, Books by Author,
History by Theme, History by Region, and History by Time Period.

Click an icon from the following illustration to find out what action it performs.
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Lists books by the author's name first.



Lists books by Title.



Lists Time Periods. Click on the globe to get a list books categorized under that time period.



Lists Regions. Click on the globe to get a list books categorized under that region.



Lists Themes. Click on the globe to get a list books categorized under that theme.



Navigation

Viewing an A-Z List of Titles

The Titles button allows you to view an alphabetical list of all available titles in Multimedia World
History.

To display a title:

1 Choose the Titles button from the button bar. A popup window containing an alphabetical list
of all available titles is displayed.
Use the scroll bar to see topics not visible in the list.

2 Highlight the work you wish to display.

3 Double-click on the selected work to display it.

See Also
Jumping from Topic to Topic

Using The Topic Icons



Navigation

Returning to the Last Topic Viewed

The Back button allows you to step backwards through topics you have previously viewed.

To backtrack through topics in the order you viewed them:
Choose the Back button from the button bar at the top of the screen.

If the current topic is the first topic you viewed, the Back button appears dimmed.

See Also
Returning to Any Topic Viewed



Navigation

Returning to Any Topic Viewed

As you view topics, a record is kept of where you have been. The History button displays a list of
the topics you have viewed, starting with the most recent. Select any topic from this list to return to
it.

To jump back to a topic using the History button:
1 Choose the History button from the button bar at the top of the screen.

The last 40 topics you have viewed are displayed in the History window.

2 Double-click the topic you want to view.
Use the scroll bar to see topics not visible in the list.

3 The History window remains displayed. You can choose another topic. You can also resize or
move the History window.

Tip: You may want to arrange the main window and the History window so that they are side by side.

To close the History window:
* Choose Cancel, or double-click the control menu box . Pressing the ESC key also closes the

History window.

See Also
Returning to the Last Topic Viewed
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—| Finding Information

Ways to Find Information In Multimedia World History

To find information in Multimedia World History, you can use the following techniques:
- View a glossary of words with popup definitions

- Take a tour of the multimedia features

- Choose topics from a keyword index

- Perform full-text searches for topic text

Using the Glossary, you can view definitions of selected words.

Using the Tour function, you can sit back and relax while the computer automatically displays the
multimedia topics containing the searched text.

Using the Index button, you can search for titles, authors, subject categories and other selected
keywords. When the selected text is found, the topic or a list of topics containing the text is
displayed.

Using the Search button, you can search on any word or words in the topics. The Search feature
not only takes you to the topic found, but highlights the word or words found by the search. You
can use search operators such as AND, OR, NOT, THRU, and NEAR to further narrow your
search.

See Also
Viewing On Screen Definitions

Taking A Multimedia Tour
Finding Information Using the Index
Using Full-Text Search



Finding Information

Viewing On Screen Definitions

The Glossary button displays an alphabetical list of words from which you can view definitions.

You can also view popup definitions while you read. Click on any red highlighted words within
the text to display a popup definition.

To view a popup definition from the Glossary button:
1 Choose the Glossary button from the button bar at the top of the screen.

2 Click on a word. A popup window with the word and its definition appear on screen.

3 Use the scroll button on the right side of the Glossary window to view words not currently
displayed.

4 The Glossary window remains open. You can perform all other functions available in
Multimedia World History while this window is displayed. You can also resize or move the
Glossary window.

To close the Glossary window:
Double-click the Control menu box.




Finding Information

Taking a Multimedia Tour

The Tour button allows you to search for text within the multimedia topics. The computer takes
you on a tour through these topics by automatically advancing from one appearance of the
searched text to the next. You can use search operators to further define the tour.

To perform a multimedia tour:
Choose the Tour button from the button bar at the top of the screen.

1

2 Type text to search or choose a previous search from the pull-down list then click the OK button
3 Adjust the speed with which the tour will proceed.
4

Select a small, medium or large tour which defines the number of multimedia topics to be
viewed.

Choose the Begin Tour button to start the tour.
You can pause the tour in the following ways:

* Choose the Pause button.
Click outside of the tour control window.

Minimize the tour control dialog box to an icon by clicking the down arrow in the upper
right corner of the window.

While the tour is paused, you are able perform other functions and move around
Multimedia World History.

7 To resume the tour, choose the Resume button.

* If necessary, maximize the tour control window, by clicking on the icon and choosing
Restore.

(¢}
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*

8 Press the End Tour button to stop the tour and return to the main window.
9 Click the Run Continuously box to create a continuous self-running tour.
Tip: You can choose the Help button in the tour control dialog box for a quick reminder on how to use the tour function.

See Also
Using Search Operators



Finding Information

Using Full-Text Search

To search for topics that contain a certain word or phrase:
1 Choose the Search button from the button bar at the top of the screen.
2 In the Search by Word box, type a search query indicating the text for which you are
searching.
To enter a previously entered search query, make a selection from the drop-down list box.
3 Under Search In, select All Topics, Selected Topic Groups or Current Topic Only.

* If you chose Selected Topic Groups, select the groups you want to search from the Topic
Groups list box.

*

To search only the topic titles, choose the Options button and select this option, then
choose the OK button.

4 Choose OK.

A list of titles of each topic containing a search hit in the Search Results dialog box is
displayed.

See Also
Browsing Through the Search Results

Using Search Operators



Finding Information

Browsing Through the Search Results

When you choose the OK button to search for information, a list of the topics that contain search
hits are displayed in the Search Results dialog box.

To view a topic in the list:
* Double-click the title.

Use the scroll bar to see titles not visible in the list.
or

* Use the Search Results buttons to move through topics.

To view Do this

Selected topic Choose the Go To button or double-
click the topic.

Search dialog box Choose the To Search button.

Next search hit in the Choose the Next Match button.

current topic

Previous search hit in Choose the Previous Match button.

the current topic

When you view a topic with search hits, the search hits in that topic are highlighted . If you
minimize the Search Results window, highlighting turns off until you maximize the Search Results
window again.

To close the Search Results window:
* Choose the Cancel button in the Search Results window.

For your convenience, the Search Results window appears on top of the main window. You can
resize it, move it, or minimize it to an icon and then restore it later when needed.

See Also
Using Full-Text Search

Using Search Operators



Finding Information

Using Search Operators

When you use the Search button to find information, you can use the operators AND, OR, NOT,
and NEAR to narrow your search. Each operator is described below. You can enter an operator in
either lowercase or uppercase letters ("and" is interpreted the same as "AND").

AND

The AND operator selects topics containing all phrases connected by AND operators. If a phrase
does not appear in quotes, any space between words in the phrase is assumed to represent an
implicit AND. For example:

Bees love Honey

This phrase finds any topic containing the three words "Bees," "love," and "Honey." This is the
same as specifying Bees AND love AND Honey. However, when quotes are used, the entire
phrase is searched. For example:

"Bees love Honey"
This phrase finds any topic containing the phrase "Bees love Honey."

OR

The OR operator selects topics containing either phrase connected by OR operators. For
example:

Bees OR Honey
This query displays topics containing either the word "Bees" or the word "Honey."

NOT

The NOT operator selects any topic that contains the phrase preceding NOT, but does not contain
the phrase following NOT. For example:

Bees NOT Honey

This query finds topics containing the word "Bees" but not the word "Honey."

NEAR

The NEAR operator selects any topic in which one phrase appears within a certain number of
words of the second phrase. The default value is 8 words. For example:

Bees NEAR Honey

This query finds any topic in which the word "Bees" appears within 8 words before or after the
word "Honey."

To change the default value, choose the Options button in the Search dialog box and enter a
new number in the NEAR Means Within box. Words that are next to each other are within one
word of each other.

Tip: You can choose the Hints button in the Search dialog box for a quick reminder on how to use search operators.

See Also
Using Full-Text Search
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Finding Information

Using Multiple Search Operators

When you use the Search button to search for information, you can use multiple search
operators to define more complex search criteria. For example, if you enter honey AND bees
NOT hives in the Search by Word box, the search will match topics that contain the words
"honey" and "bees" but do not contain the word "hives."

By default, operators are evaluated from left to right. You can use parentheses to specify a
different order--operators within parentheses are evaluated first.

This query Searches for

honey OR bees AND hives Topics containing either the word honey or the
word bees in addition to the word hives.

honey OR (bees AND hives) Topics containing the word bees and the word
hives or topics containing the word honey.

honey OR bees NOT hives Topics containing either the word honey or the
word bees but not the word hives.

honey OR (bees NOT hives) Topics containing the word bees but not the word

hives or topics containing the word honey.

Tip: You can choose the Hints button in the Search dialog box for a quick reminder on how to use search operators.

See Also
Using Full-Text Search

Using Search Operators
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Printing and Copying

Printing and Copying Information

You may want to use information in Multimedia World History in other applications, such as word
processors. You can copy text and graphics onto the Windows Clipboard. From the Clipboard,
you can paste the information into any Windows application. You can also print out topics, and
change printers from within Multimedia World History.

See Also
Obiject Linking and Embedding

Copying Topic Text
Printing Topics



Printing and Copying

Changing Printers and Printer Options

Topics are printed on the default printer. If you have installed more than one printer in Windows,
you can make any of your installed printers the default printer. You can also change the default
printer options.

To change printers:
1 From the File menu, choose Print Setup.

2 Select Specific Printer.
3 From the drop-down list box, select the printer that you want to set as your default.

If this file is not in the list box, switch to the Control Panel, select Printers, and activate the
printer you want to use. Then switch back to Multimedia World History.

4 Choose OK to close the Print Setup dialog box.

To change printer options:
1 From the File menu, choose Print Setup.

2 Choose the Options button to change the default printer options.

The options available depend on the type of printer you have selected.
3 Choose the options you want, and then choose OK.
4 Choose the OK button to close the Print Setup dialog box.

To change printer orientation, paper size, or source:
From the File menu, choose Print Setup.

1
2 Select Portrait or Landscape for the orientation.

3 Select the paper size you want from the drop down list box.

4 Select the paper source you want from the drop down list box.
5 Choose OK to close the Print Setup dialog box.

For more information on setting up printers, see your Windows documentation.

See Also
Printing Topics



Printing and Copying

Printing Topics

To print an entire topic:
1 Display the topic.
2 From the File menu, choose Print Topic.

To print part of a topic:
Display the topic.
From the Edit menu, choose Copy.
In the Copy dialog box, select the text you want to print, and then choose the Copy button.
Paste the text into a word processing application.
Use the Print command from the application's File menu to print the text.

a b WODN -

See Also
Copying Topic Text



Printing and Copying

Copying Topic Text

To copy text to the Clipboard:
1 Display the topic that contains the text you want to copy.

2 From the Edit menu, choose Copy.

3 Select the text you want to copy in the Copy dialog box.

4 Choose the Copy button.

To paste the Clipboard contents into another document, use the Paste command from the
application's Edit menu.

See Also
Object Linking and Embedding



Printing and Copying

Object Linking and Embedding

The information in Multimedia World History can be copied into other applications with Object
Linking and Embedding (OLE) capabilities.

Two types of documents are used to perform OLE functions. The source or server document such
as drawing software contains the original object. The object is then copied into the destination or
client document such as a word processor.

For detailed instructions on performing this function and to determine whether the application you
are using is OLE compatible, refer to your Windows and other software documentation.

To copy objects from Multimedia World History to other applications, press the Print Screen key.
The entire screen will be copied.

See Also
Copying Topic Text
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Bookmarks and Annotations

Annotating Multimedia World History

The Bookmark and Annotation features allow you to save information in reference to specific
topics. A bookmark is simply that: a marker which "saves your place". Like any book, you can have
many bookmarks in Multimedia World History. When the bookmark is selected, you jump directly
to that topic.

Annotations are simply notes or comments "paper clipped" to a topic. It's the same as paper
clipping a note to a page in a book. You can copy and paste text in annotations.

See Also
Using Bookmarks

Annotating a Topic



Bookmarks and Annotations

Using Bookmarks

Just as you can place bookmarks in a printed book to mark specific references, you can place
bookmarks at the topics you view frequently. Once you have placed a bookmark at a topic, you
can quickly display that topic from the Bookmark menu.

To insert a bookmark:
1 Display the topic in which you want to place a bookmark.

2 From the Bookmark menu, choose Define.

3 The topic title is proposed as the bookmark name. If you want to change the name, type a
new name in the Bookmark Name box.

4 Choose OK.
The bookmark name appears on the Bookmark menu.

To remove a bookmark:
1 From the Bookmark menu, choose Define.

2 Select the bookmark you want to remove.
3 Choose Delete.
4 Choose OK.

See Also
Jumping to a Bookmark



Bookmarks and Annotations

Jumping to a Bookmark

After you have inserted bookmarks, you can go directly to them at any time.

To go to a marked topic:
* From the Bookmark menu, choose the topic you want to view.

Underlined numbers precede the first nine bookmark titles. You can press the corresponding
number key or choose the bookmark title to go quickly to a marked topic.

If more than nine bookmarks have been defined, choose More from the Bookmark menu.
Select a bookmark, and then choose the Go To button.

See Also
Using Bookmarks



Bookmarks and Annotations

Annotating a Topic

You can attach your own comments to a topic. When you annotate a topic, a paper clip icon is
placed to the left of the topic heading. The paper clip icon reminds you that you have attached text
to this topic.

To attach text to the current topic:
1 From the Edit menu, choose Annotate.

2 Type the text in the Annotation edit box.
If you make a mistake, press Backspace or the Delete key to erase any unwanted characters
and then continue typing.

3 Choose OK when you have finished the annotation.

To remove an annotation:
1 Display the topic where you made the annotation.

2 Click the paper clip icon.
3 Choose the Delete button.

See Also
Viewing an Annotation




Bookmarks and Annotations

Viewing an Annotation

To view an annotation:
1 Display the topic where you made the annotation.

2 Click the paper clip icon.
3 Choose the Save or Cancel button when you have finished reading the annotation.

Tip: Place a bookmark at an annotation to return to it quickly.

See Also
Copying and Pasting Annotations

Using Bookmarks



Bookmarks and Annotations

Copying and Pasting Annotations

You can copy text from an annotation to the Clipboard or paste text from the Clipboard into an
annotation.

To copy text from an annotation to the Clipboard:
1 Display the topic where you made the annotation.

2 Click the paper clip icon.
3 If you want to copy all of the annotation, choose the Copy button.

If you want to copy only a portion of the annotation, select the text in the Annotate edit box, and
then choose the Copy button.

To paste text from the Clipboard into an annotation:
1 Display the topic where you made the annotation.

2 Click the paper clip icon.
3 Position the insertion point where you want to paste the text.

To position the insertion point, point and click the mouse or press the arrow keys.
4 Choose the Paste button.

If any text is selected (highlighted) when you choose the Paste button, it is replaced by the new
text.

See Also
Copying Topic Text
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Buttons and Menus

File Menu Commands

The File menu contains these commands:
- Open
- Print Topic
- Print Setup
- Exit
Scroll down to see descriptions of each command.
Open
Displays a dialog box in which you can select and open a title.
Print Topic
Prints the displayed topic (assuming you have a printer installed and turned on).
Print Setup
Displays a dialog box in which you can change printer settings before printing.
Exit
Closes Multimedia World History.

See Also
Changing Printers and Printer Options

Printing Topics




Buttons and Menus

Edit Menu Commands

The Edit menu contains these commands:
- Copy
- Annotate

Copy

Places a copy of the displayed topic in a dialog box, where you can select text to copy to the
Clipboard.

Annotate

Displays a dialog box in which you can attach your own notes to the current topic.

See Also
Copying Topic Text

Annotating a Topic



Buttons and Menus

Bookmark Menu Commands

The Bookmark menu contains these commands:
- Define
- More
Scroll down to see descriptions of each command.

Define

Displays a dialog box in which you can add a bookmark to the current topic or delete an existing
bookmark.

More

This command appears only when more than nine bookmarks have been added to the Bookmark
menu and displays a dialog box in which you can select a bookmark.

See Also
Using Bookmarks

Jumping to a Bookmark



Buttons and Menus

GoTo Menu Commands

The GoTo menu contains these commands:
- Timeline
- Glossary
- This Day in History
- Tour
- Historical Figures Gallery
- Video and Animation Gallery
- Sound Gallery
- Picture Gallery
- Books by Title
- Books by Author
- Books by Theme
- Books by Region
- Books by Time Period

Home

Returns you to the main screen.

Glossary

Displays a glossary of words. Click on a word to display a popup definition.
This Day in History

Jumps to the January screen

Tour

Takes you on a multimedia tour.

Historical Figures Gallery

Displays the first topic in the historical figures gallery.
Video and Animation Gallery

Displays the first topic in the video and animation gallery.
Sound Gallery

Displays the first topic in the sound gallery.

Picture Gallery

Displays the first topic in the picture gallery.

Books by Title

Displays a list of books title first.

Books by Author



Displays a list of books author's name first.

Books by Theme

Displays a list of themes which, when clicked, renders a list of books categorized by theme.
Books by Region

Displays a list of regions which, when clicked, renders a list of books categorized by region.
Books by Time Period

Displays a list of time periods which, when clicked, renders a list of books categorized by time
period.



Buttons and Menus

Using the Button Bar
Use the following buttons to browse and look up information in Multimedia World History.

Home I Titles Igategmyl List Igalleryl Index IEInssau,ll Search I Histnrgl Tour I Back I

Select any button from this illustration to find out what action it performs.




Displays the main screen. For more information, see Using the Main Screen Icons.



Displays an alphabetical list of titles available in Multimedia World History. For more information, see
Viewing an A-Z List of Titles, Using the Main Screen Icons.



Displays a popup window listing the available topics under the selected area. For more information,
see Jumping From Topic to Topic, Using The Topic Icons, Browsing through Multimedia Sequences.



Displays the category screen which allows you to choose books from five different
categories: Books by Title, Books by Author, History by Theme, History by Region, and
History by Time Period.



Brings you to the multimedia galleries screen. For more information, see Jumping to the Multimedia
Galleries Screen, Using the Main Screen Icons.




Displays an index of keywords and phrases. You can select a word from the index list or type one in
yourself, displaying topics that contain information related to the selected text. For more information, see
Finding Information Using the Index.



Displays a glossary of words from which you can view popup definitions. For more information, see
Viewing On Screen Definitions.



Backtracks through topics in the order viewed. For more information, see Returning to the Last Topic
Viewed.



Displays a list of the last 40 topics you have viewed. Double-click any topic title to redisplay the topic. For
more information, see Returning to Any Topic Viewed.




Allows you to search for any combination of words and phrases, and then browse the topics that contain
search hits. For more information, see Using Full-Text Search.




Automatically advances from one appearance of the searched text to the next within the multimedia
topics. For more information, see Taking a Multimedia Tour.



Keyboard Techniques

Using Accelerator Keys
The following is a list of keyboard shortcuts available in Multimedia World History:

Keys Action
Ctrl+C, Ctrl+Ins Copies the displayed topic text
to the clipboard
Ctrl+Shift+Alt+F1 Jumps to the Opening Screen
Alt+O Jumps to the Main screen
Ctrl+Shift+Alt+F2 Brings up the Index dialog box
Ctrl+Shift+Alt+F3 Takes you to the last topic
viewed (Back)
Ctrl+Shift+Alt+F4 Brings up the History list

Tab Moves to the next hot spot

Shift+Tab Moves to the previous hot spot

Ctrl+Tab Highlights all displayed hot
spots

Esc Removes the top-most popup

Alt Removes all popups

Alt+F4 Exits Multimedia World History

F1 Displays Help screens

Press ALT key plus underlined letter of a command word to perform that function. (i.e., pressing
Alt+0O functions identically to the Home button by returning you to the main screen)



Home button

The button that displays the main screen for Multimedia World History.



Hints button

Hints.___ I
In the Search dialog box, the button that shows examples of how to enter search queries.




Titles button

This button displays a table of contents of all available works in Multimedia World History, title first.



Category Screen

This screen allows you to choose books from five different categories: Books by Title, Books by
Author, History by Theme, History by Region, and History by Time Period.



Index button

The button that displays a dialogue box containing selected keywords and the number of related topics.



Back button

This button backtracks through topics in the order you viewed them.



History button

Displays a list of the last 40 topics you viewed.



List button

Displays a window containing the topics available under the selected area.



Gallery button

Brings you to the multimedia galleries screen.




Glossary button

Displays a list of words from which you can view popup definitions.



Search button

The button that searches for all topics containing a particular word or combination of words.



Next Match button

Mext Match

The button in the Search Results dialog box that displays the next search hit in the current topic not
currently displayed on the screen.




Previous Match button

Previous Match

The button in the Search Results dialog box that displays the previous search hit in the current topic not
currently displayed on the screen.




To Index button

The button in the Topics Indexed dialog box that takes you back to the Index dialog box.



To Search button

To Search I
The button in the Search Results dialog box that takes you back to the Search dialog box.




Options button

Options. ..

The button in the Search dialog box that displays the available search options. The Search Options dialog
box is where you can change the NEAR value, select topic titles as the search domain, or select to search
from a list of previous topics found.



Go To button

The button in the Topics Indexed and the Search Results dialog box that displays the selected topic
from the list.



bookmark

A name associated with a topic for easy reference. Bookmarks appear on the Bookmark menu.
When you select a bookmark from the menu, the topic associated with that bookmark is displayed.



Clipboard

The Microsoft Windows application that holds cut or copied information, which you can then insert
into another file. Whenever you use a Cut, Copy, or Paste command, you are using the Clipboard.



main screen

The "control panel" for Multimedia World History. From this screen, you can select which part of
the title you want view and what functions you want to perform.



topic

A unit of information containing any combination of text, graphics and multimedia options.



Topics Indexed

An index dialog box that lists topics from an index search which allows you to browse and go to
topics in the list.



Search Results

The dialog box that lists topics containing search hits from a search query and allows you to
browse and go to topics in the list.



search query
A combination of words, phrases, and operators which indicate the text to be searched.



browse sequence

A sequence of topics arranged so that you view them in succession.



topic title
A name identifying a topic found by searches from the Index and Search commands.



jump
A hot spot that displays another topic in the main window.



hot spot

A word, phrase, or picture, that when selected, performs an action such as jumping to a new topic
or displaying a popup window.



search hit
An occurrence of text in a topic that matches the search query entered for the Search command.



current position

The position in an audio or video sequence that is currently being played, indicated by the thumb
in the slider control.



thumb

J

The pointer in the slider of a controller indicating the current position in the audio or video sequence.




slider

The control in an audio or video sequence that contains the thumb, which indicates the current
position in the audio or video sequence.



multimedia galleries screen

All multimedia topics in Multimedia World History are available from this screen.



multimedia

Multimedia World History incorporates multimedia features including pictures, graphics, audio-
enriched animations, videos and narrations.



popup
Smaller windows which are displayed over the main window when a hot spot is selected. To
close popup windows, click outside of the popup region or press the ESC key.



multimedia icon

A hot spot which allow you to experience pictures, narrations, videos and animations.



Tour Button

Displays the tour dialogue box allowing you to take a multimedia guided tour of the searched text.



Begin Tour button

LGOI, 1 O
The button in the tour control dialog box which starts a multimedia topic tour.



Pause button

Pausze

The button in the tour control dialog box which stops the multimedia tour until the user presses the
Resume button.




Resume button

Besume

The button in the tour control dialog box which continues the paused multimedia tour.



End Tour Button

The button in the tour control dialog box which stops the multimedia tour and closes the tour control
dialog box.



Object

Any combination of text, audio and graphics to be used as a single unit and copied into another
application.



Linking

Creates a link between the original object and all copies of the object in other software
applications. Changes made to the original or any of its copies will appear on all versions of the
object. In order to link an object, it must first be saved as a document.



Embedding

Creates a copy of an object from one software application to another. Once an object is
embedded, changes can be made to either the original or the copy without effecting the other.



control menu box

Double-clicking on this box allows you to close the selected window.



Author Icon

This icon appears in the non-scrolling region containing the title before every work. For more
information, see Using The Topic Icons.



Finding Information

Finding Information Using the Index

Using the Index button is like using the index of a book. You can browse through a list
of keywords, and then jump to a topic by selecting a word from the index. Items
found in the index include titles, authors and subject matter.

To look up a topic using the index:
1 Choose the Index button from the button bar.

2 Type the word you want to search for or select the word from the Index list.
You can press a key on your keyboard to move quickly to different parts of the list.
For example, type "S" to move to words beginning with the letter "S" and then type
"O" to see words beginning with "So."

3 Select a word or phrase then choose OK.
If only one topic is linked to the word, that topic is displayed.
If there is more than one topic linked to the word, the topics are displayed in the
Topics Indexed dialog box.
To return to the Index, choose the To Index button.

4 Double-click the topic you want to view, or select the topic and choose the Go To
button.

See Also
Using Full-Text Search
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Multimedia Features

Using the Multimedia Controller

You can play an audio or animation sequence using a control panel that appears within a topic or
that pops up when you select a hot spot. Either type of sequence may include the multimedia

controller, as shown below:

:@ J(m]n]*]

Select any control from this illustration to find out what action it performs.

To control a sequence that does not have a control panel:
* Click the window while the sequence is playing to stop it.
* Click the window after stopping the sequence to start playing it again.



Stop Button

E Stops playback of the audio or animation sequence.



The slider control lets you drag the thumb to move the current position back (left) or forward
(right) in the audio or animation sequence.




Play Button
Starts playing the presentation.



Pause Button

EI Stops playing the presentation until the user presses this button again.



Multimedia Features

Using Multimedia Icons

These icons allow you to view the multimedia topics available in Multimedia World History. You
can access these icons wherever they appear on screen.

L
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Select an icon from this illustration to find out what action it performs.
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&

See Also
Using the Multimedia Controller




Displays pictures with short descriptions.



<A al kgl
{ewl MVMCI2, ViewerMCI, [device WaveAudio][buttons play pause stop][slider][caption 'Hear -

Hindenburg'][autostart]!hndnburg.wav}
Allows you to listen to narrative clips.



{ewl MVMCI2, ViewerMClI, [device AVIVideo][buttons play pause stop][slider][caption 'See - The
Modern Universe."|[autostartimodern.avi}

Allows you to view audio-enriched animations.



Multimedia Features

Browsing Through Multimedia Topic Sequences

The multimedia topics are linked to one another in a browse sequence. This browse feature lets
you scan the topics one by one within the Galleries area.

To display the next or previous multimedia topic:
Choose the in the button bar.

*

Tip: If the multimedia topic is the first in the browse sequence, the << button appears dimmed

If the multimedia topic is the last in the browse sequence, the >> button appears dimmed

See Also
Jumping From Topic to Topic
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Displays the previous topic in the browse sequence.




Displays the next topic in the browse sequence.







